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TraiNminaTor2 : documentation  

Avril 2024 - IGN 

TraiNminaTor2 est un plugin QGIS dédié à la saisie d’annotation sur un ou deux millésimes. 

La saisie s’effectue sur des segmentations (Pyram, Superpixel, ...) effectuées au préalable. 

Une des particularités de TraiNminaTor2 est sa gestion de segmentation pyramidale/multi-

niveau.   
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I. Installation du plugin 

Configuration minimum nécessaire : version 3.22 de Qgis 

Pour l’annotation bi-date, il est très fortement conseillé d’avoir deux écrans. 

1. Installation  

L’installation du plugin peut se faire de deux manières :  

- En copiant le plugin dans le dossier contenant les Plugins QGIS 

- En utilisant la méthode d’installation par ZIP dans QGIS 

a. Par copie dans le dossier 

Récupérer le dossier du plugin (actuellement : trainminator) et le copier dans son répertoire 

utilisateur :  

- Sous Windows : 

C:\Utilisateurs\toto\AppData\Roaming\Qgis\QGis3\profile\default\pyhon\plugins 

- Sous Linux : ~/.local/share/QGIS/QGIS3/profiles/default/python/plugins/ 

b. A partir du ZIP 

Ouvrer QGIS, puis aller dans Extensions -> Installer/Gérer les extensions -> Installer depuis un zip 

Chercher ensuite l’archive ZIP du plugin puis cliquer sur “Installer le plugin”.  

 

Si un message d’avertissement apparait, cliquer sur Oui 
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Une fois l’installation terminée, le message suivant doit apparaitre : 

 

2. Activation dans QGIS 

Une fois l’installation terminée (peu importe la manière), il faut activer le plugin depuis QGIS. Lancer 

QGIS (si il n’est pas déjà ouvert) et aller dans Extensions -> Installer/Gérer les extensions -> Installées 

et cocher la case à côté de trainminator2. 

Dans le cas où l’installation s’est faite par ZIP, le plugin doit être coché pas défaut. Il faut cependant 

le décocher puis le recocher pour compléter l’installation.  
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3. Réglage de QGIS 

Les pyramides utilisées, comme les dessins que l’utilisateur va effectuer pour sélectionner les objets, 

peuvent contenir des géométries invalides. Pour rendre l’outil pleinement utilisable, effectuer ce 

réglage : 

Préférences -> Options -> Traitement-> Général -> Filtrage des éléments invalides :  

Ne pas filtrer (meilleurs performances)  
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II. Lancement de la session 

Ouvrir (si ce n’est pas déjà fait) QGIS sans projet 

Dans la barre des tâches, cliquez sur l’icône  Trainminator2 comme sur l’image ci-dessous.  

 

La fenêtre suivante doit s’ouvrir : 

 

Ouvrir ensuite le projet QGIS (extension .qgs ou .qgz) sur lequel vous travaillez. Deux cas de figures 

possibles :  

- Le projet correspond à un projet d’annotation mono-date. Dans ce cas, la fenêtre de 

TraiNminaTor va être modifiée pour ressembler à l’image ci-dessous. 
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- Le projet correspond à un projet d’annotation bi-date. Dans ce cas, une seconde fenêtre 

TraiNminaTor va s’ouvrir et afficher le second millésime du projet. Le premier millésime sera 

affiché dans la fenêtre principale, de même que les outils nécessaires à la mise en place de la 

saisie. Ci-dessous, un exemple avec chaque fenêtre sur un écran différent.  

 

Sur la fenêtre principale (celle contenant la barre des tâches), chargez la nomenclature en allant dans 

Nomenclature -> Open nomenclatures 

 

Une fenêtre d’exploration de fichier va s’ouvrir, chercher alors le fichier .csv correspondant à la 

nomenclature voulue.  
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Remarque : Si la préparation du projet a bien été faite, l’explorateur de fichier doit s’ouvrir par 

défaut sur le bon dossier.  

Si tout se passe bien, les classes décrites dans la nomenclature doivent apparaitre à droite de (ou 

des) fenêtre(s) comme ci-dessous 
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Dans le cas bi-date, la nomenclature sera présente sur les deux fenêtres.  

 

Appuyer ensuite sur START (bouton vert) pour démarrer la session de saisie. Une fois le bouton 

cliqué, l’application QGIS ne va plus répondre pendant plusieurs minutes, c’est NORMAL et il suffit 

de patienter.  
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Que se passe-t-il alors ? 

• Si on avait déjà travaillé sur ce projet : des données existent déjà dans le dossier 

LABELED_DATA. Elles sont chargées. On peut alors reprendre un travail de labellisation en 

cours. 

• Si c’est la première fois qu’on travaille sur ce projet : les shapes destinés à accueillir les labels 

vont être créés dans le dossier LABELED_DATA, par duplication des données initiales. 

Quand l’application réponds à nouveau, vous devez avoir une (ou plusieurs) couches ajoutées dans le 

groupe de couches LABELED_DATA (à gauche dans les fenêtres). 

Dans le cas d’une saisie bi-date, chaque fenêtre aura un groupe de couche avec un nom différent, par 

exemple LABELED_DATA_2019 et LABELED_DATA_2016. 

Une fois la session démarrée, vous devez avoir les interfaces suivantes : 

- Pour une saisie mono-date 
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- Pour une saisie bi-date 

 

- Pour une saisie avec un suivi par patch. Dans ce cas, une couche supplémentaire avec pour 

nom patches apparaitra dans le (ou les) groupe(s) LABELED_DATA comme sur l’image ci-

dessous. 
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III. Outils de saisie 

TraiNminator offre les fonctionnalités décrite ci-dessous, on les combinera pour effectuer la saisie. 

Des exemples de saisie seront donnés ensuite.  

ATTENTION : En mode bi-date, le choix de la classe, de la tâche et de la méthode de sélection se 

fait indépendamment sur les deux fenêtres !  

1. Description des fonctionnalités 
 

a. Choisir une classe 

Pour choisir une classe de saisie, cliquer sur la classe dans la nomenclature.  

 

Elle doit ensuite apparaitre après SELECTION  

  

b. Type de tache 

Trois tâches sont disponibles et on sélectionnera celle voulue en cliquant sur le bouton associé : 

• Labellisation (Labelling) : La classe choisie sera affectée aux objets sélectionnés. 

• Supprimer toutes les classes (Delete All) : La classe des tous les objets sélectionnés sera 

remise à vide. 

• Supprimer la classe choisie (Delete Current) : La classe vide sera affectée aux objets 

sélectionnés qui ont comme classe celle choisie. 
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Si on travaille sur du multi-niveau, les taches appliquées à un niveau se répercuterons sur les autres 

niveaux. 

c. Méthode de sélection 

La sélection des objets sur lesquels s’effectuerons les opérations se fait en dessinant des points sur la 

carte.  

Pour dessiner un point, on effectuera un (ou plusieurs) clic gauche. A part pour la sélection par point, 

on peut aussi laisser le clic gauche appuyé et déplacer la souris pour ajouter un point à chaque 

déplacement tant que le clic est enfoncé. La saisie se terminera par un clic droit sur la souris.  

Lors de la saisie, on peut utiliser les deux raccourcis suivants :  

• Ctrl+Z pour retirer le dernier point ajouté à la saisie 

• ECHAP pour annuler toute la saisie en cours. 

Les objets seront ensuite sélectionnés en fonction du mode de sélection choisi. Par défaut, les objets 

sélectionnés apparaitront en jaune lors de la saisie. Les modes de sélection sont les suivants :  

• Point : Les objets sélectionnés sont ceux intersectant les points saisis. 

• Ligne (Line) : Les objets sélectionnés sont ceux intersectant la ligne construite à partir des 

points saisis. 

• Polygone large (Large-Polygon) : Les objets sélectionnés sont ceux intersectant le polygone 

construit à partir des points saisis. 

• Polygone stricte (Strict-Polygon) : Les objets sélectionnés sont ceux entièrement inclus dans 

le polygone construit à partir des points saisis.  

 

ATTENTION : Une fois la saisie validée, il est impossible de revenir en arrière. 

d. Changer le niveau de segmentation 

TraiNminaTor permet de travailler sur plusieurs niveaux de segmentation imbriquées. Une saisie se 

fait sur un seul niveau à la fois mais on peut changer le niveau de segmentation sur une même 
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session de saisie, par exemple faire une saisie grossière à un niveau de segmentation grossier puis 

affiner en allant sur une segmentation plus fine. Les saisies faites sur un niveau de segmentation se 

propage sur les autres en respectant certaines règles : 

- Un segment plus grossier aura une classe si tous les segments plus fins le composant ont la 

même classe. Le segment plus grossier aura alors cette même classe. Dans l’exemple ci-

dessous, tous les segments de niveaux plus fins sont aussi de classe culture.  

 

- Quand on annote un segment d’un niveau plus grossier, la classe annotée sera propagée si 

les segments plus fins n’ont pas de classe. Dans l’exemple, les segments qui possède déjà une 

classe (pelouse pour au Nord-Ouest et dans les trouées et bâtiment pour le bâtiment) ne 

verront pas leur classe modifiée lorsque tout le segment grossier est annoté en feuillus. Dans 

ce même cas, le segment grossier n’aura pas ailleurs pas la classe feuillus non plus (certains 

des segments plus fins ayant une autre classe que celle-ci).  
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- Quand on annote un segment d’un niveau plus grossier qui avait une classe, la classe 

annotée se propagera sur les segments plus fins ayant aussi cette classe.  En annotant la 

parcelle centrale où la végétation n’est pas encore très haute en broussaille, l’annotation se 

propagera aux segments plus fins. On se placera pour se faire sur un niveau de segmentation 

plus fin.  
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Dans tous les cas, la classe affichée sera celle du segment au niveau le plus fin.  

On peut changer le niveau de la segmentation sur laquelle on travaille en utilisant le slider en haut de 

la fenêtre.  

On peut aussi passer vers un niveau plus fin avec le raccourci TAB, et passer vers un niveau plus 

grossier avec le raccourci MAJ+TAB. 

e. Suivi de la saisie 

En mode patches de suivi, on va avoir la possibilité de désigner des zones (patch) de saisie comme 

terminées. Il faut pour cela avoir la couche « patches » dans le groupe de couche LABELED_DATA.  
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Remarque : Ce mode est facultatif est doit être mise en place lors de la préparation du chantier de 

saisie.  

Ensuite, pour valider une zone, on va se placer sur le niveau le plus grossier dans le slider de choix 

des niveaux 

 

On va ensuite choisir l’outil de Labelling avec n’importe quelle classe et n’importe quelle méthode de 

sélection, par exemple le point. On sélectionne ensuite la zone à valider à l’aide d’un clic gauche de la 

souris. La zone sélectionnée apparait alors en jaune.  

 

On peut ensuite sélectionner d’autres zones si on veut. Pour valider que cette zone est terminée, on 

fait un clic droit sur la souris. La zone apparait alors en gris opaque et masque ortho+saisie. 
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Si on s’est trompé, pas de panique, on peut rechanger l’état d’une zone en utilisant cette fois l’outil 

Delete_All ou Delete_Current et en refaisant la même manipulation que pour valider une zone. On 

fait un (ou plusieurs) clic gauche pour sélectionner la ou les zones.  

On fait un clic droit pour valider le fait qu’on souhaite ré-afficher cette zone comme non terminée. 

L’objet ne masque alors plus l’ortho et la saisie 
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ATTENTION : Dans le cas bi-date, on ne pourra valider une zone que si la saisie est complète, c’est-

à-dire que tout segment annoté à une date doit l’être aussi sur l’autre.  

 

f. Autres fonctionnalités 

 

• Le raccourcis “I” permet d’activer un affichage du (ou des) classe(s) des segments survolés 

par la souris. 

 

• Le raccourcis “W” permet d’afficher le groupe de couche CONTEXT. 

• Le bouton Fit All permet d’afficher toute la zone de travail. 

• Le bouton “Show Current” permet de n’afficher que la classe choisie sur la carte. 

• En mode bi-date, le bouton Synchro Views permet de synchroniser les deux fenêtres. Ce 

mode est activé par défaut. 

• En mode bi-date, le bouton Synchro Levels permet de synchroniser les niveaux de 

segmentations des deux fenêtres. 

• En mode bi-date, les segments annotés sur une dates mais pas sur l’autres seront indiqués 

sur la fenêtre où l’annotation est manquante par un hachage rouge comme en haut à gauche 

sur l’exemple ci-dessous.  
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2. Exemple de saisie 

Quelques exemples de saisie avec l’outil.  

a. Saisie d’arbre avec des points 

Pour ce premier exemple, on souhaite annoter une partie des arbres présents au bord du lac dans la 

classe feuillus. On configure l’outil de saisie de cette manière : 

Classe : Feuillus, c’est la classe qu’on veut donner ici. 

Tache : Labellling, on veut annoter des objets. 

Type de sélection : Point, les arbres qu’on va annoter sont tous représentés par un ou deux segments 

à ce niveau de segmentation.  
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On commence ensuite à faire des clics gauches sur la carte pour ajouter des points à prendre en 

compte. A chaque clic, un point va apparaitre et le segment qui le croise sera mis en jaune 

On continue jusqu’à avoir tous les objets qui nous intéresse. 
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On peut enfin faire un clic droit pour valider la saisie. Les points ajoutés vont disparaitre et les 

segments qu’on a choisis vont être annotés en feuillus.  

Et voilà les arbres sont annotés et on peut recommencer une autre saisie ! 

 

b. Saisie d’une haie 

Dans ce deuxième exemple, on souhaite annoter une haie dans la classe broussaille. On configure 

l’outil de saisie de cette manière : 

Classe : Broussaille 
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Tache : Labellling, on veut annoter des objets 

Type de sélection : Line, on va faire une ligne qui suit la haie pour l’annoter 

On commence à faire des clics gauches pour ajouter des points. Cette fois-ci, les points forment une 

ligne et tous les segments croisant la ligne sont mis en jaune.  

 

On continue la saisie 
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On continue en saisissant toute la haie 

 

On fini par un clic droit pour valider la saisie et passer la classe des segments sélectionnés en 

broussaille. La ligne va alors disparaitre. 
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On peut ensuite commencer une autre saisie.  

c. Supprimer une mauvaise saisie 

Pour ce troisième exemple, on a fait une mauvaise saisie et on a annoté les voitures présentes sur un 

parking en bâtiment alors qu’elles doivent être en imperméable comme le parking.  
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On configure l’outil de saisie de cette manière : 

Classe : Bâtiment, on va vouloir retirer que des objets classés en bâtiments. 

Tache : Delete Current, on veut supprimer l'annotation de la classe bâtiment uniquement. 

Type de sélection : Large Polygone, on va dessiner un polygone sur tout le parking. 

Et on commence la saisie en faisant toujours des clics gauches. Comme cette fois on a choisi une 

sélection en mode polygone, c’est un polygone qui va apparaitre sur la carte et tous les objets le 

croisant vont être sélectionnés.  

 

On continue jusqu’à avoir sélectionné tous les segments du parking 
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On fini par le clic droit pour valider la saisie. Les polygones qui avaient la classe bâtiment dans ceux 

qu’on a sélectionnés vont perdre leur classe. Les autres ne seront pas modifiés.  

 

d. Saisir un changement sur du bi-date 

Dans ce dernier exemple, on travaille sur une saisie bi-date pour annoter des changements. Dans ce 

cas, on va faire deux saisies (une par fenêtre). Dans l’exemple, un bâtiment a été construit entre les 

deux dates. Pour faire la saisie, on va saisir le bâtiment sur la date où il apparait et ce qu’il a remplacé 

dans la date d’avant. 
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Sur la date où le bâtiment est présent (2019), on configure l’outil ainsi :  

Classe : Bâtiment 

Tache : Labelling 

Type de sélection : Large Polygone, on va dessiner un polygone. 

On dessine ensuite le polygone avec des clics gauches pour sélectionner tout le bâtiment 

 

Et on valide la saisie avec un clic droit 
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On passe ensuite sur la deuxième fenêtre. Après la saisie du bâtiment, les mêmes polygones 

apparaitront avec des rayures rouges sur cette fenêtre 
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On va sur cette seconde fenêtre configurer l’outil dans un premier temps ainsi : 

Classe : Zone imperméable 

Tache : Labelling 

Type de sélection : Large Polygone, on va dessiner un polygone. 

ATTENTION : La configuration de l’outil est propre à la fenêtre sur laquelle on travaille. Ainsi, il 

faudra bien faire attention lors de la saisie à configurer l’outil comme il faut.  

On dessine le polygone sur la partie imperméable qu’on a annoté sur l’autre millésime. 

Et on fait le clic droit pour valider la saisie. On change ensuite la classe annotée en Feuillus pour 

annoter le bout d’arbre qui nous manque 
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On confirme avec le clic droit et on a fini de saisir ce changement. On peut ensuite passer à celui du 

jardin en dessous remplacé par un parking. 
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Au final, notre saisie apparait ainsi sur les deux fenêtres.  

 

3. Clôturer une session de saisie 

Avant de clôturer la session de saisie, cliquer sur le bouton Fill Pyramid.  

 

Si tous se passe correctement, le bandeau suivant doit apparaitre dans la fenêtre de QGIS.  

 

Et une couche doit aussi apparaitre dans le groupe de couche FINAL_DATA comme ci-dessous. 
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En mode bi-date, si des segments ne sont pas annotés pour les deux dates, le message suivant va 

apparaitre et un zoom sera fait sur un des segments sans annotations. 

 

Si tout s’est bien passé, on peut clôturer la session de saisie en cliquant sur le bouton STOP 

ATTENTION : En quittant QGIS, vous pouvez avoir un message demandant si le projet doit être 

enregistrer. Il ne faut en aucun cas sauvegarder le projet ! Ne vous inquiétez pas, votre travail de 

saisie est sauvegardé en permanence dans les couches. 

4. A ne pas faire 
 

- Bien qu’on ait accès aux coches dans le gestionnaire de couche, éviter de décocher le niveau 

courant. 

- En cours de sélection, une couche temporary_point (ou _line ou _surface) apparaît dans le 

gestionnaire de couche. Ne pas y toucher. 

- Quand le plugin est ouvert, ne pas toucher au gestionnaire de couche de la fenêtre principale 

de QGIS. Si on souhaite supprimer ou ajouter des couches, fermer le plugin, modifier le 

projet QGIS, et relancer le plugin. 
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